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Media Connect (Client for Archive Management)

Basic work with the MAM archive is implemented through the Media Connect client application, which
allows viewing/adding/deleting/editing materials, setting access rights, managing archive operations,
etc.

Configuring

At the first launch of Media Connect, implement several settings: Media Connect→File
menu→Configure→Storage tab

Connect to the database and select a metadata schema

Press Add to add the MAM server database.
Press Metadata Schema… and select the server with a configured metadata schema from the
drop-down list.

Specify metadata schema fields to be displayed in Media Browser

https://wiki.skylark.tv/_detail/manual/mam_maconnect.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/manual/mam
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Press the Configure XMP Columns… button. Select the field name from the drop-down list and
press Add. Press Ok.
Activate the selected items in Thumbnail view and List view areas.
Values in selected fields will be displayed in corresponding columns, in the right section of the
Media Browser window.
Press Ok to save changes, or move to the next step.

Set the profile of material displayed in the File Monitor window

Go to the Preview tab.
The Use Lowres Proxy parameter provides a profile to be used for displaying the clip in File
Monitor: ON - for LRV, OFF - for BRV. It is recommended to set this parameter to the “ON”
position to reduce the network load.
Press Ok to save changes.

Interface

The Media Connect app includes several windows:

Window Description
Media Browser

File Monitor Displays video and metadata for the clip selected in Media Browser. Allows setting
In/Out points, key frames, etc.

https://wiki.skylark.tv/_detail/manual/mam_maconnect_config_xmp_col.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/mam_maconnect_config_xmp_col2.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/mam_maconnect_config2.png?id=manual%3Amediaconnect
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Window Description
Browser job list The list of import/export events.
Archive Queue The archiving queue.
Key frames
Segment Editor Editor of segments (special key frames).
Search Media The tool for search in the MAM database, with filters.
Media Bins The window for creating assets of media-clips.

Materials Sheet
Launches the metadata editor window: Clip Materials Sheet. Starting from version
2.4.54, the metadata editor window can be customized by adding user and group
tabs with an individual set of editable metadata fields. The function is configured in
the metadata schema.

Event Logs The window for viewing logs of work with a database.

Database Security Policies

The Media Connect interface allows setting security policies for MAM database folders.

Media Browser window→Media Folder→Folder→Right click menu→Edit Permissions…

Parameter Description

Users and groups The list of users and groups. Clicking the line allows viewing/changing access
rights for a certain user or group.

Allow mask/Deny mask
Permissions The window for setting access rights.

List of Policies

Policies, accessible only for the database root directory.

https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_54
https://wiki.skylark.tv/_detail/manual/mam_mc_folder_permissions.png?id=manual%3Amediaconnect
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Policy Name Description Additional Information

USER_READ reading user
information

USER_MANAGE user management

VOLUME_READ_INFO reading MAM tree
information

METADATA_GET_SCHEMA reading a metadata
schema

If the Deny value is set, an attempt to edit
metadata fields will display an empty window.
A similar error may appear, if a metadata
server is not selected in settings:
File→Configure→Storage→Metadata
Schema….

METADATA_SET_SCHEMA recording the
metadata schema

METADATA_SET_VALUE_SETS setting new metadata
values

MEDIABIN_LIST receiving the list of
bins

MEDIABIN_CREATE creating a new
recycle bin

MEDIABIN_DELETE deleting a bin
MEDIABIN_WRITE recording to the bin

MEDIABIN_READ reading the bin
content

GC launching garbage
collection in the base

Excluded since version 2.0.176, then included
to the SYSTEM option

SYSTEM
configuring system
settings and
implementing system
tasks

VIEW_EVENT_LOG
access to viewing
logs of work with a
database.

(Media Connect→Window→Event Logs)

Policies accessible to any database directory.

Policy Name Description Additional Information
FOLDER_READ reading the folder content
FOLDER_CREATE creating folders
FOLDER_DELETE deleting folders
FOLDER_RENAME renaming folders
FOLDER_CHANGE_PRIV changing user access for folders
FOLDER_CHANGE_ARCH_POLICY changing archiving settings for folders
FOLDER_CHANGE_TRIGGERS changing trigger settings for folders Since version 2.0.188
FOLDER_CHANGE_TAGS changing tag settings for folders Since version 2.1.2
FILE_READ reading files
FILE_CREATE creating files

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_176
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_188
https://wiki.skylark.tv/changelog/slneo_2.1#s_2_1_2
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Policy Name Description Additional Information

FILE_DELETE deleting files

Since version 2.0.53,
restoration from the
recycle bin no longer
requires FILE_DELETE
rights for a folder with
the bin. If the rights are
absent, the clip will be
restored and the link
copy will stay in the bin.
When using the function
of deleting to the bin, the
Everyone group must get
FILE_CREATE and
FILE_DELETE rights to the
Trash folder, otherwise
the following error will
occur after a deletion
attempt: “Error occured
while deleting file:
Permission denied”.

FILE_RENAME renaming files
CHANGE_PURGE_TIME changing the automatic deletion date
FILE_TRIM trimming a video file

FILE_CHANGE_FIELDS changing additional fields (user field
1..8)

FILE_CHANGE_EXT_METADATA changing XMP metadata
FILE_FLUSH deleting a HiRes file
FILE_FLUSH archiving a HiRes file
FILE_RESTORE restoring a HiRes file from the archive
FILE_CHANGE_CERT1 changing the Reviewed status
FILE_CHANGE_CERT2 changing the Segmented status
FILE_CHANGE_CERT3 changing the Trimmed status
FILE_CHANGE_CERT4 changing the Annotated status
FILE_CHANGE_CERT5 changing the Approved status
FILE_CHANGE_CERT6 changing the #6 status
FILE_CHANGE_CERT7 changing the #7 status
FILE_CHANGE_CERT8 changing the #8 status
FILE_CHANGE_CERT9 changing the #9 status
FILE_CHANGE_CERT10 changing the #10 status
FILE_CHANGE_CERT11 changing the #11 status
FILE_CHANGE_CERT12 changing the #12 status
FILE_CHANGE_CERT13 changing the #13 status
FILE_CHANGE_CERT14 changing the #14 status
FILE_CHANGE_CERT15 changing the #15 status
FILE_CHANGE_CERT16 changing the #16 status
FILE_EDIT editing the file
FILE_CHECK_MEDIA Schedule HIRES media file check

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_53
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Policy Name Description Additional Information

USER_PRIV_FILE_BLOCK_OVERRIDE
permission to delete clips blocked from
deletion by the program channel with
the activated "Block clip deletion”
option

Added in version 2.2.17.

SHORTCUT_CREATE creating a shortcut
SHORTCUT_DELETE deleting a shortcut
KEYFRAME_CHANGE_SEGMENT editing segments
KEYFRAME_CHANGE_SECONDARY editing secondary events
KEYFRAME_CHANGE_OTHER editing other key points

ARCHIVE_MANAGE_QUEUE managing the archiving and restoring
queue

List of values:

Value Description
Allow Allowed
Deny Denied
Inherent from Parent Inherited from a parent element (catalogue)

Archiving Policies

The Media Connect interface allows setting policies of files archiving to the tape.

“Media Browser window→Media Folder→Folder→Right click menu→Archive Policy…”

Parameter Description

Inherit from Parent Activates inheritance of an archiving policy from a parent container
(folder)

Automatically Archive After
Automatically archives files from a folder after N days. 0 - immediate
archiving. Never - never archive. The time is calculated from the moment
of creating the HiRes profile.

Automatically Flush After

Flush on low space Automatically deletes the BRV copy of a file, if less than N GB of disk
space is free at the volume and the file has an ARC profile.

Folder Triggers

The function of setting triggers to database folders is added in the 2.0.188 version. Trigger is a

https://wiki.skylark.tv/manual/program_channel_configuration#bm_blockclipdeletion
https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_17
https://wiki.skylark.tv/_detail/manual/mam_archive_policy.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_188
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sequence of actions implemented in case of triggering the set condition.

Compatibility Statement. When updating existing
installation note that the database format stays unchanged
in case if no triggers have been created. If triggers are
created, previous software versions will not be able to load
databases containing triggers (before downgrading,
manually delete all triggers).

Creating Trigger

Creating and editing triggers is implemented in the Media Connect app: Media Browser
window→Media Folder→Target folder→Right click menu→Triggers….

The user must have FOLDER_CHANGE_TRIGGERS rights for a
target folder. User choice is implemented in database
connection settings.

The window with a list of configured triggers of a folder

Parameter Value
Name The list of created triggers
Add… Creating a new trigger
Edit… Editing a selected trigger
Delete… Deleting a selected trigger

The window for creating/editing a trigger

https://wiki.skylark.tv/_detail/manual/maconnect_trigger_1.png?id=manual%3Amediaconnect
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Parameter Value
Trigger name The displayed trigger name.

Run as user
Launching trigger operations will be implemented under the name of a database user
selected in this dialogue. It is recommended to create separate users to execute
trigger operations.

Delete source
clip

Deletes the clip in case of successful actions(s) execution. If the clip operation is
implemented through a shortcut, the app will delete the shortcut and save the
original clip placed in another folder.

Condition

The area of defining the trigger conditions. Conditions are added by clicking Add. If a
file in the target folder satisfies the set condition, it is counted as “true”, which leads
to executing an action with this file. Simultaneously activated conditions are united
by the logical “AND”, creating a combined condition, where all elements must be
“true” so the action is implemented.

The Negate parameter is a logical “NOT” that inverts the condition value (NOT TRUE
= FALSE, NOT FALSE = TRUE).

Operation

The area defines different file operations that will be executed, if all certain
conditions in the left part will be “true”. File operations are executed consequently,
starting with the first one. If an error occurs during the process, further actions are
not implemented and the general execution status becomes Failed (More details on
the statuses of trigger processing see below).

List of Supported Conditions

Condition Desctiption Additional Parameters for
Condition

None the value is not set no parameters
Media
Finalized

File recording is completed (file does not
have the PART-media status) no parameters

https://wiki.skylark.tv/_detail/manual/maconnect_trigger_2.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/maconnect_trigger_negate.png?id=manual%3Amediaconnect
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Condition Desctiption Additional Parameters for
Condition

Has Profile The file has a profile

•
Profile - the profile value from the
drop-down list
    ⚬
HiRes (BRV)
    ⚬
Proxy (LRV)
    ⚬
Archive (ARC)
    ⚬
Web Proxy 1 (WP1)
    ⚬
Web Proxy 2 (WP2)
    ⚬
Web Proxy 3 (WP3)
    ⚬
Web Proxy 4 (WP4)
    ⚬
Web Proxy 5 (WP5)
    ⚬
Web Proxy 6 (WP6)
    ⚬
Web Proxy 7 (WP7)
    ⚬
Web Proxy 8 (WP8)

Has Certificate The file has a status
•
Certificate - the status value from the
drop-down list Values for the list will be
taken from metadata schema settings.
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Condition Desctiption Additional Parameters for
Condition

Metadata Field
The condition will be true, of a field of the
basic metadata set coincides with the set
mask

•
Field name - the list of values
    ⚬
Media ID
    ⚬
Comment
    ⚬
Type
    ⚬
Orig File
    ⚬
Derived From
    ⚬
User 1
    ⚬
User 2
    ⚬
User 3
    ⚬
User 4
    ⚬
User 5
    ⚬
User 6
    ⚬
User 7
    ⚬
User 8
•
Value mask - the text field supporting
masks.
    ⚬
* - conforms any number of symbols.
    ⚬
? - conforms one symbol.
    ⚬
\ - escaping special characters, such
as *, ? and [
    ⚬
[] - conforms to any symbol from the
set (may contain symbol ranges like
[a-zA-Z0-9]). A set cannot be empty.
The “]” symbol may be included to the
set as the first symbol.
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Condition Desctiption Additional Parameters for
Condition

XMP Field The condition will be true, if the XMP
metadata field coincides with the set mask

•
Field name - the list of values,
containing available XMP metadata
fields loaded from the metadata
schema.
•
Value mask - the text field supporting
masks.
    ⚬
* - conforms any number of symbols.
    ⚬
? - conforms one symbol.
    ⚬
\ - escaping special characters, such
as *, ? and [
    ⚬
[] - conforms to any symbol from the
set (may contain symbol ranges like
[a-zA-Z0-9]). A set cannot be empty.
The “]” symbol may be included to the
set as the first symbol.

XMP Date
The condition for comparing XMP fields to
the Date type. The condition truth depends
on a selected option of comparison in the
Comparison field. Added in 2.4.54 version.

•
Field Name - the XMP field name.
•
Value - the variant of comparing the
XMP field to the Date field. The
condition is true, if:
    ⚬
Greater Than - the XMP field value is
greater, than in the Date field,
    ⚬
Less Than - the XMP field value is
less, than in the Date field,
    ⚬
Equals - the XMP field value is equal
to the Date field value,
    ⚬
Exists - the XMP field value is exists.
•
Date - the date in the “DD/MM/YYYY”
format.

XMP Boolean

The condition for comparing XMP fields to
the Boolean type. The condition is true, if
the XMP metadata field value coincides
with the Value field. Added in 2.4.54
version.

•
Field Name - the XMP field name.
•
Value - a drop-down list supporting
values:
    ⚬
True - true,
    ⚬
False - false.

Is Shortcut The condition is true, if a file is a shortcut no parameters

Has Del Time The condition is true, if the Del Time value
is specified for a clip (it's not endless). no parameters

https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_54
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_54
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Condition Desctiption Additional Parameters for
Condition

Del Time Earler
The condition is true, if the Del Time
parameter is specified and set for
execution in fewer days than the value
specified in the Days field.

•
Days - 0-1000 days

Has Key Frame
The condition is true, if there are set key
frames of the specified type (Key Frame
Track).

•
General
•
Segments
•
Secondary Event
•
Cue Point
•
Icon
•
Picture

The list of supported operations.

Operation Desctiption Additional Parameters for Operation
None the value is not set no parameters

Set Del Time

Setting the deletion time for a file.
Note that a shortcut cannot have its
own parameters, except location, so
Del Time is applied to the basic
asset of this shortcut.

•
Days - Disabled, 1-1000 days

Create
Shortcut

Creates a file shortcut in the
selected folder.

•
Folder - a text field containing a path to the folder existing in the
database. The path is specified in the format folder1/folder2 (no
slash in the end).

Create Web
Profile

Creates a request for generating one
of eight web-profiles of the material.
The 2.0.x line includes only WP1 and
WP2 profiles with fixed settings. The
2.1.x line has defined WP1-WP8
profiles with parameters
configurable in the database.

•
Profile - selecting a profile from the drop-down list:
    ⚬
WP1
    ⚬
WP2
    ⚬
WP3
    ⚬
WP4
    ⚬
WP5
    ⚬
WP6
    ⚬
WP7
    ⚬
WP8
•
Force recreate - this option sets automatic recreating profiles, if
they have already been created before applying triggers.
•

Use separate thread - 
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Operation Desctiption Additional Parameters for Operation

Create Icon
Creating a draft (icon or picture) for
a clip displayed on the VOD portal
pages.

•
Key Frame Track - the type of the required key frame:
    ⚬
None - key frames are not used, the screenshot position is specified
by static offset via Position Offset.
    ⚬
General
    ⚬
Icon
    ⚬
Picture
•
Icon folder - the name of a database folder for saving the draft file.
The file name is generated automatically.
•
Resolution - specify the image size in the WxH format, where W is
width in pixels and H is height in pixels.
•
XMP Metadata field - specify a metadata schema field for saving
the link to the created draft, for instance: sl:icon or sl:picture.
•
Position Offset - screenshot position offset timecode.

Set XMP
Field

Specifies or clears the metadata
XMP field value.

•
Field to set - selecting a field with a value to be updated. Contains
available XMP metadata fields loaded from the metadata schema.
•
Value Source - selecting the type of a data source for filling the
specified field:
    ⚬
Metadata Field - selecting the field value from the basic metadata
set. The Value field will display a drop-down list with names of fields
from the basic metadata set.
    ⚬
User Defined - Setting a random text value. The Value field will
contain a text area for entry. Added in 2.4.54 version.
    ⚬
Clear Field - Delete the current value from the metadata XMP field.
Added in 2.4.54 version.
•
Value - the value depends on the Value Source setting.

https://wiki.skylark.tv/_detail/manual/maconnect_trigger_create_icon.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_54
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Operation Desctiption Additional Parameters for Operation

Set XMP
Date

Specifies or clears the metadata
XMP field value with the Date type.
Added in 2.4.54 version.

•
Field to set - selecting a field with a value to be updated. Contains
available XMP metadata fields of the Date type, loaded from the
metadata schema.
•
Value Source - selecting the type of a data source for filling the
specified field:
    ⚬
User Defined - Setting a random date text value. The Value field will
contain a text area for the date entry.
    ⚬
Now - set teh current date.
    ⚬
Clear Field - Delete the current value from the metadata XMP field.
    ⚬
Value - the value depends on the Value Source setting.

https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_54
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Operation Desctiption Additional Parameters for Operation

Send
Message

Sending a message to users via the
built-in Messenger service. Added in
2.4.81 version.

•
Recipient - The recipient name. The recipient can be a user or a
group.
•
Title - The message title. The Insert Var button allows adding a
variable to the field.
•
Body - The field for the text message entry. The Insert Var button
allows adding a variable to the field.
•
Attach triggered media - attach a triggered asset to the message.
•
Priority - The value for setting the color marker of the message
priority.

•
Address - IP address of the server with the launched message
service.
•
Messenger # - The number of the message service. The value
starts with 1.
•
User - The username to be used in the service. The set username
will be used for sending and receiving messages. The user must exist
in the database specified in the Messenger service server part
settings.
•
Password - The user password.
•
Insert Var - the button to add a variable to Title and Body fields.
The following variables are available:
    ⚬
Title
    ⚬
In Point
    ⚬
Out Point
    ⚬
Duration
    ⚬
Source Name
    ⚬
Orig Name
    ⚬
Orig In Point
    ⚬
Type
    ⚬
Comment
    ⚬
Clip Name - clip MediaID
    ⚬
Layer
    ⚬
Triggered Time - time of triggering
    ⚬
Triggered Date - date of triggering
    ⚬
XMP поля - available XMP fields of an extended metadata set.
    ⚬
Related Folder - the folder containing the processed clip.

https://wiki.skylark.tv/manual/messenger
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_81
https://wiki.skylark.tv/_detail/manual/maconnect_messenger_priority.png?id=manual%3Amediaconnect
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Trigger Processing Status

The triggers processing status for a specific clip (asset) can be viewed in the window: Media
Connect→Window→Clip Materials Sheet→Locations And Triggers. To quickly open this window, use the
Show Info item by right clicking in Media Browser.

If the operation was applied to the clip through a shortcut, the trigger processing status will be
displayed for the clip and all its shortcuts.

Parameter Value
Name Trigger name

https://wiki.skylark.tv/_detail/manual/maconnect_trigger_menu_1.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_triggers.png?id=manual%3Amediaconnect
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Parameter Value
Folder Name of the folder, where the trigger was configured

Status

The result of trigger actions
•
Done - The action is successful.
•
Executing - The action is in the process of execution.
•
Failed - An error has occurred during the trigger action execution. One or several
actions have not been executed. The error message is displayed under the status.

•
Condition - The file does not satisfy the trigger conditions, the action is not complete.

Time The time of file processing

 

Resetting the processing status of the selected trigger is implemented by the Reset Triggers
command in the Media Browser right-click menu. Select one or several triggers and press OK. Triggers
with the reset status of processing will be applied to files.

Folders Metadata (Tags)

Tags have appeared since version 2.1.2, providing an option of setting additional metadata for
database folders.

Creating and editing folder tags is implemented in the Media Connect app: Media Browser
window→Media Folder→Target folder→Right click menu→Tags….

https://wiki.skylark.tv/_detail/manual/maconnect_trigger_status_error.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/maconnect_trigger_menu_2.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/maconnect_trigger_reset.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/changelog/slneo_2.1#s_2_1_2
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The user must have FOLDER_CHANGE_TAGS rights for a
target folder. User choice is implemented in database
connection settings.

Only one tag is defined at the moment - Sticky Color. The tag allows setting the background color for
playlist events, depending on the folder containing the played clip. The event background color is set
in the moment of dragging the clip from Media Browser to the playlist window. When saving a playlist
to a CLF file, color information is saved in the parameter <item item_color=“%23FFFFFF”>,
where FFFFFF is color value as three pairs of hex digits (RGB).

Since version 2.1.22, Sticky Color also sets the background color for the folder name in Media
Browser.

Video Material Profiles

One video material can be stored in the database in different versions called profiles. Available
profiles are displayed in the Profiles column of the Media Browser window.

https://wiki.skylark.tv/_detail/manual/maconnect_tags_menu.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/_detail/manual/maconnect_tags_2.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/changelog/slneo_2.1#s_2_1_22
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Profile name Description
BRV The initial video in the original quality
LRV The database proxy-copy for online viewing in client applications
ARC The archive copy of the original video.
WP1 The web proxy-copy.
WP2 The web proxy-copy.
WP3 The web proxy-copy. Appeared in the 2.1 product line
WP4 The web proxy-copy. Appeared in the 2.1 product line
WP5 The web proxy-copy. Appeared in the 2.1 product line
WP6 The web proxy-copy. Appeared in the 2.1 product line
WP7 The web proxy-copy. Appeared in the 2.1 product line
WP8 The web proxy-copy. Appeared in the 2.1 product line

Creating and deleting WebProxy copies is available by right clicking the selected clip.

Clip Management Menu

The right click menu in Media Browser gives access to different MAM functions for working with clips.

https://wiki.skylark.tv/_detail/manual/mam_mc_profiles.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/changelog/slneo_2.1
https://wiki.skylark.tv/changelog/slneo_2.1
https://wiki.skylark.tv/changelog/slneo_2.1
https://wiki.skylark.tv/changelog/slneo_2.1
https://wiki.skylark.tv/changelog/slneo_2.1
https://wiki.skylark.tv/changelog/slneo_2.1
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Menu item Description
Export… Opens an export dialog for the selected clip.
Export Audio… Opens an audio track export dialog for the selected clip.
Render… The option is similar to the selected clip export dialog.
Attach Media… Connecting video materials to the selected asset.

Create Proxy…
Creates a task for forming an LRV profile for the selected clip. This option is
used when a clip doesn't have an LRV proxy-copy, or if the LRV profile is in the
base, but the physical proxy-copy file is absent.

Delete Proxy… Deleting the LRV proxy-copy of a selected clip.
Schedule Duration
Check

Allows forced check of BRV copy duration and updating metadata parameters
according to the actual file. Added in version 2.0.36. More details.

Copy Copying a clip in the database

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_v3.png?id=manual%3Amediaconnect
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Menu item Description
Paste

Delete
Deletes a clip from the database (metadata, BRV and LRV). Deleting BRV from
the archive folder is managed by the Enable archive copy deletion setting (see
above).

Delete Hires… Deleting the BRV proxy-copy of a selected clip. This action is irreversible.

Delete At…

Setting the date and time of clip automatic deletion from the database.

Kill list…

Batch deletion of files from the database. All MediaID must be listed line by
line. The list may be loaded from a file by the Read file… button.

New→Media
Asset…

Creating a new asset with specifying the format and planned duration. Duration
will be adjusted after connecting the video material and asset.

https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_deleteat.png?id=manual%3Amediaconnect
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Menu item Description

New→Note…

Creating a new news note with text input, displayed at the VOD portal. VOD.

New→URL…

Creating a destination link to a network resource. The resource could be an
Internet image, for instance.

New→Clock…

Creating a combined clip for displaying TV clock, containing links to clips with
clock background, arrows and audio.

New→Local
stream…

Creating a Live clip containing a link to the media data stream local source.
(e.g. stream name: Capture_1). This technology allows playing the server input
signal within a playlist. Viewing a live-clip in the File Monitor window will be
available only during local playback at the server.

New→Graphics… Launches the graphics editor for creating a new graphic composition.

https://wiki.skylark.tv/manual/vod
https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_newnote.png?id=manual%3Amediaconnect
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Menu item Description

New→Text…

Creating a text object containing text information for captions and referring to
design templates (graphic compositions with parametrization).

Edit… Editing object settings. For example, it will open the graphics editor for a
graphic object.

Apply Design…

Linking a design template to the text object. Text information is unavailable for
editing in this window.

https://wiki.skylark.tv/_detail/manual/maconnect_new_text.png?id=manual%3Amediaconnect
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Menu item Description

Show info…

Opens the Locations And Triggers tab in the Clip Materials Sheet window. 

Change fields…

Opens the Clip tab in the Clip Materials Sheet window. Clip and User Tabs allow
editing data in user fields of the basic metadata set. The dialog may be used
for batch editing of information in the pre selected group of clips. The app will
save values only for filled out fields, empty values will be ignored while saving.

Edit Metadata…

Opens the first available tab with fields of the extended metadata set (fields
are loaded from the connected XMP metadata schema) in the Clip Materials
Sheet window.

https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_triggers.png?id=manual%3Amediaconnect
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Menu item Description

Edit Status…

Opens a dialog for editing statuses (certificates) in the Clip Materials Sheet
window. Names and the number of statuses may be configured in the
metadata schema (see above). The status condition flag may have three
states:
•
ON (black check mark) - the status is set,
•
OFF (no check mark) - the status is removed,
•
Indefinite condition (grey check mark) - appears in case of the group setting
of statuses, when the status condition of selected clips differs. Statuses with
indefinite condition are ignored, allowing for saving differences while group
editing.

Starting from version 2.4.58, there is an option of setting a status color in
metadata schema settings. After setting a status, the clip icon gets a strip of a
corresponding color.

Edit Segments… Opens the segment editor.

Archive Launches the archiving process for a clip BRV profile. The archiving process is
managed in the Archive Queue window.

Restore Launches the process of restoration for a BRV profile. The restoring process is
managed in the Archive Queue window.

Flush HiRes Launches deletion of a BRV profile from the folder with HiRes originals.
Archive and Flush The group task that combines archiving and further deletion of BRV.
Cancel Archiving
Operation Cancelling execution of the archiving operation.

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_status.png?id=manual%3Amediaconnect
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Menu item Description

Find Segments…

The dialog displays all clip segments marked with key frames of Segment Start
and Segment End types.

Reset triggers… Resets the processing status of one or several triggers for a selected group of
clips.

Web
Profiles→Create
Profiles…

Creating the necessary Web Profiles for a selected group of clips. The Recreate
if exists option allows recoding the selected profile if it’s already been created
before.

Web
Profiles→Delete
Profiles…

Deleting the necessary Web Profiles for a selected group of clips.

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_findseg.png?id=manual%3Amediaconnect
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Dragging in Media Browser Window (Drag-and-Drop)

Media Browser extensively uses clip dragging possibilities:

Where Condition Result

To the Windows folder Left click
Copying a clip BRV copy to the folder. The function is
available if Client Path is configured in the Storage
Parameters tab and the app runs as the current
Windows user.

To the Windows folder Right click
Copying a clip LRV copy to the folder. The function is
available if Client Path is configured in the Volumes tab
and the app runs as the current Windows user.

To the database folder
different from the current
one

Mouse button Moving clip to a specified database folder.

To the database folder
different from the current
one

Mouse
button+Ctrl

Creating a clip copy (Shot Clip) in the destination
folder.

To the current database
folder Mouse button

Starting from 2.4.x version this function is no longer
supported. In previous versions: creating a clip copy
(Shot Clip) in the current database folder.

To the database folder
different from the current
one

Mouse button+Alt Creating a Shortcut. This operation requires basic MAM
licensing.

Key Frames and Segment Editor

The function of setting key frames for clips allows marking and segmenting materials, defining the
places of graphics playback, etc.

Adding a key frame is implemented in the File Monitor window.

The button opens a dialogue for adding a new key frame.1.
The button opens a list for a quick transition to the selected key frame.2.

https://wiki.skylark.tv/_detail/manual/maconnect_keyframes_monitor.png?id=manual%3Amediaconnect
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Parameter Value
Position Key frame position time code in the ‘’HH:MM:SS:FF'’ format

Keyframe
Type

Type of a key frame. The option is used in the condition for launching program channel
actions.
•
General - a standard type of a key frame.
•
Segment Start - sets the segment starting point with the Title name.
•
Segment End - sets the segment ending point with the Title name.
•
Secondary Event - sets the point of launching secondary events.
•
Icon - sets the point of automatic (triggered) generation of a clip icon in VOD
•
Picture - sets the point of automatic (triggered) generation of a clip poster in VOD
•
Profanity start and Profanity end - sets the video fragment for applying the closing
effects. The Playlist actions section of the program channel allows configuring actions
for markers of Profanity Start and Profanity End types, which will lead to: video
blurring, sound toning, turning off sound in parts of video placed between Profanity
Start and Profanity End type markers. Added in 2.4.14 version.
•
Cue Point and GoTo cue - These markers can be used for a quick transition to
marked points and for skipping certain video parts. The Playlist actions section of the
program channel allows configuring the action that will trigger by the Cue Point marker
and launch the Next Marker processor, which will switch to the next marker of the Goto
Cue type. Thus, video parts placed between Cue Point and Goto Cue markers can be
automatically skipped. Added in 2.4.14 version.

Title
A random key frame name. The option is used in the condition for launching program
channel actions. When segmenting, SegN names are used, where N is the segment
sequence number (Seg1, Seg2 etc).

Comment Commentary.
Keywords Key words.

https://wiki.skylark.tv/_detail/manual/maconnect_keyframes_new.png?id=manual%3Amediaconnect
https://wiki.skylark.tv/manual/vod
https://wiki.skylark.tv/manual/vod
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Parameter Value

Blur rect

The field replaces Keywords, when selecting Keyframe Type = Profanity start. It sets a
rectangle blurring area in the x,y,w,h format (e.g.: «0.2,0.2,0.5,0.3»). The field value is
set through the editor available by the button […].

Key frames editor

The window for working with key frames: ‘MediaConnect→Window menu→Key frames. It allows
viewing, moving, editing and deleting key frames.

^Element^Description^ |1|The button opens a dialogue for adding a new key
frame| |2|The button activates the mode of viewing key frames as icons|
|2|The button activates the mode of viewing key frames as a list| |4|Turns on
displaying only the key frames between In and Out points of the clip| |5|Key
frame position screenshot| |KF Position|Key frame position time code in the
‘’HH:MM:SS:FF'’ format| |KF Out Position|Not used| |KF Title|A random key

frame name. |Comment|Commentary| |User| | |Track|Keyframe
type. |Keywords|Key words.| === Segment editor === The window for work with
segments: '’MediaConnect→Window menu→Segment editor. It displays grouped key frames of

https://wiki.skylark.tv/_detail/manual/airmgr_filemonitor_keyframes_blur.png?id=manual%3Amediaconnect
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Segment Start and Segment End types, and allows viewing, moving, editing and deleting segments.

Element Description
1 The button opens a dialogue for adding a new key frame
2 The button activates the mode of viewing key frames as icons
2 The button activates the mode of viewing key frames as a list
KF Position The time code of the segment start key frame position in the “HH:MM:SS:FF” format
KF Out Position The time code of the segment end key frame position in the “HH:MM:SS:FF” format

KF Title The segment name. When segmenting, SegN names are usually used, where N is the
segment sequence number (Seg1, Seg2 etc).

Comment Commentary

User

Track
Keywords Key words.

Dragging in Media Browser Window (Drag-and-Drop)

Media Browser extensively uses clip dragging possibilities:

Where Condition Result

To the Windows folder Left click
Copying a clip BRV copy to the folder. The function
is available if Client Path is configured in the
Storage Parameters tab and the app runs as the
current Windows user.

To the Windows folder Right click
Copying a clip LRV copy to the folder. The function is
available if Client Path is configured in the Volumes
tab and the app runs as the current Windows user.

To the database folder
different from the current
one

Mouse button Moving clip to a specified database folder.

https://wiki.skylark.tv/_detail/manual/airmgr_segment_editor.png?id=manual%3Amediaconnect
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Where Condition Result
To the database folder
different from the current
one

Mouse button+Ctrl Creating a clip copy (Shot Clip) in the destination
folder.

To the current database
folder Mouse button Creating a clip copy (Shot Clip) in the current

database folder.
To the database folder
different from the current
one

Mouse button+Alt Creating a Shortcut

Manual Import of Materials to МАМ

Use dragging to the Media Browser window or the Import media files button in the left bottom part of
Media Browser.

In the Select Source dialog, select the source and the imported clip.

Parameter Description

Storage

Type of source:
•
SL Media Storage - the database,
•
Local File System - the local or network Windows folder,
•
P2 Card,
•
Sony SxS.

Folder The path to the source folder
Names The imported clip name (several clips can be imported simultaneously)
Ok Selecting the destination place - Select Destination

https://wiki.skylark.tv/_detail/manual/mam_maconnect_import_4.png?id=manual%3Amediaconnect
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Parameter Description

Storage

Type of source:
•
SL Media Storage - the database,
•
Local File System - the local or network Windows folder,
•
P2 Card,
•
Sony SxS.

Folder A path to the destination folder
New… Creates a new folder in the selected directory

Name Allows specifying a new name for the imported clip (is absent in case of
simultaneous import of several clips).

Copy mode

•
Remux/Transcode – copying and processing the material.
•
Raw HIRES Only – byte-by-byte copying the original copy (BRV) without processing.
•
Raw HIRES Proxy – byte-by-byte copying the original copy (BRV) and the proxy-
copy (LRV) without processing.

On Exists

Definition of actions in case of names coincidence of the imported clip and the clip
existing in the database:
•
Fail - give an error.
•
Overwrite – erase the current clip and record a new one in any case (the PART
message will appear on the clip icon during recording). The initial metadata will be
replaced.
•
Overwrite different – erase the current clip and record a new one, if the clips differ
(the PART message will appear on the clip icon during recording). Old clip metadata
will be replaced by the new one.
•
Replace - the file will be completely saved and then renamed, deleting the existing
clip with the same name. In this case the PART message will not appear and the
material will be renamed right after the end of copying. We recommend this for
updating clips in an on-air playlist. Old clip metadata will be replaced by the new
one.
•
Rename – the imported clip will be renamed in case of coincidence of names (the
clip name will be added with information on the copying time in the format:
YYYY.MM.DD HH.MM.SS.FF).
•
Attach – updates BRV and LRV of a given clip. The current metadata is saved.

https://wiki.skylark.tv/_detail/manual/mam_maconnect_import_3.png?id=manual%3Amediaconnect
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Parameter Description

Max transfer rate The maximum copying speed concerning the real time. For example: DV25Mb/s*3x
file = 75Mb/s stream. Values: Unlimited, 1x-10x.

Copy Timecode Allows copying the original timecode. The original time code can be viewed in File
Monitor with the activated OrigTC option.

Copy Metadata

Copy Status Copy the material status. The option works, if the metadata schema server is
specified.

CDate from
Sets the initial date of clip creation. If the parameter is activated, all selected clips
with equal or later creation date will be processed. It is used for manual
synchronization of storages at the main and backup servers after the routine
maintenance.

CDate to
Sets the final clip creation date. If the parameter is activated, all selected clips with
equal or earlier creation date will be processed. It is used for manual
synchronization of storages at the main and backup servers after the routine
maintenance.

Ok Transition to the choice of transcoding options or import execution, if the mode of
byte-by-byte copying is selected.

Log of Database Operations (Event Log)

In version 2.2.8 the function of logging database operations has been added. Viewing logs is
implemented in the Event Log window launched via the menu: MediaConnect→Window→Event
Logs→Open New→Name of the connected database.

The maximum logs storage time is set by the Event Log History parameter of the Storage parameters
tab, placed in database settings of the server control panel.

Output Management

Option Value
Date Setting the date for filtering data from the log storage.
Prev Viewing events for the previous day (relative to the date set in the Date field).
Next Viewing events for the next day (relative to the date set in the Date field).

https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_8
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Option Value

Search

Opening the setting window of extended search in the log storage.

•
Start - the starting date of the search range (inclusive)
•
Finish - the ending date of the search range (inclusive)
•
User - search by users
•
Title - search by MediaID
•
Folder - search by the folder name
•
Action - search by an action (selected from the list)
The User, Title, Folder, Action fields allow using wildcards.

User Filtering search results by the User field. Using wildcards is allowed.
Folder Filtering search results by the Folder field. Using wildcards is allowed.
Title Filtering search results by the Asset field. Using wildcards is allowed.

Action

Filtering by Action (selected from the list). The system is logging the following user
actions:
•
Create Asset - creating clips,
•
Rename Asset - renaming clips,
•
Modify Asset - modifying clips,
•
Move Link - moving clips between folders,
•
Remove Link - deleting clips,
•
Remove Shortcut - deleting shortcuts,
•
Archive Link - archiving clips,
•
Cancel Archive Link - cancelling the archiving procedure,
•
Restore Link - restoring clips from the archive,
•
Flush HiRes - deleting a HiRes copy of the material.

Apply Filter Applies filter settings to search results.
Refresh

Using wildcards while searching:

* - replaces any number of symbols,

https://wiki.skylark.tv/_detail/manual/maconnect_mam_log_2.png?id=manual%3Amediaconnect
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? - replaces one symbol.

Error List for Archiving and Restoring Operations

Error
Code Name Description

0 ERR_NOERROR No errors
-1 ERR_UNKNOWN Unknown error
-2 ERR_UNK_MIME_TYPE Unknown source media type
-3 ERR_UNK_ARGUMENT Unknown argument
-4 ERR_SRC_NOVIDEO Input doesn't contain any video
-5 ERR_WRITER An error occurred during writer initialization
-6 ERR_READ An error occurred during reading
-7 ERR_WRITE An error occurred during writing
-8 ERR_EXISTS Destination media already exists
-9 ERR_SRC_NOAUDIO Input doesn't contain any audio
-10 ERR_IMCOMP_FMT Imcompatible container format
-11 ERR_SRC_STAMP Source clip was modified during transfer
-12 ERR_CANCELLED Cancelled by user
-13 ERR_DEMO Demo mode
-14 ERR_SRC_STORAGE Source storage could not be resolved
-15 ERR_SRC_DELETE Source clip could not be removed
-16 ERR_START_WRITE An error occurred while starting write operation

-17 ERR_DST_STAMP_CLNT An error occurred while retrieving destination stamp
(initialization)

-18 ERR_DST_STAMP_RSLV An error occurred while retrieving destination stamp
(resolve_name)

-19 ERR_SRC_NOT_SUPP Source video codec or container is not supported
-20 ERR_SRC_RESOLVE Source clip can't be resolved
-21 ERR_OFFLINE File offline
-22 ERR_OPEN An error occurred trying to open the file
-23 ERR_ACCES_DENIED Permission denied
-24 ERR_METADATA_UPDATE An error occurred while trying to update metadata
-25 ERR_SCAN_CANCELLED Cancelled by user while scanning media
-26 ERR_NO_BRV_PROFILE The BRV profile is absent
-27 ERR_NO_ARC_PROFILE The ARC (archival) profile is absent
-28 ERR_CANT_ONLINE
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